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Introduction 
 
Microsoft Word is know as a “Word Processing” program. It’s ancestors, DisplayWrite, 
Multimate Advantage, WordStar—have all died out and rarely ever seen in business today. One 
remaining exception is WordPerfect, which is still popular with the legal industry. 
 

For this handout (in color) and more, visit my teacher’s website at: 

 www.clearcutcomputing.com/school 
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The "Anatomy" of the Word Window 
 
The typical program window will look similar to that shown below.  It is possible to customize your own display, 
but that is a topic for discussion later on.   
 

 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
Title Bar – Displays the name of the program (in the screen above: Microsoft Word), and usually, the name of the 
file that you are currently working on. On the right you have the three buttons that make up the "control box."  
From left-to-right, these buttons are: 
 
 Minimize – to shrink the application to the Windows Task Bar. 
 Windowed/Full Screen mode — controls the size of the window. 
 Close — to close the document window or shut down the program. 
 
 
Ribbons — Populated with buttons; which are shortcuts to the various features of the program. 
 
Status Bar — Shows helpful messages while you use various features of the program. 
 
 

TABS 

RIBBONS 

ZOOM CONTROL 

STATUS BAR 

RULER BAR 

QUICK ACCESS TOOLBAR TITLE BAR 
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Ribbons (which have replaced the Toolbars) 
Word provides you with many Ribbons, which contain (almost) all of the commands in the program. Each ribbon 
contains commands of the same category. Some ribbons will have additional commands that  “appear” based on 
what you are doing.  For example, when you are working in a table, ribbon tabs labeled, Design and Layout appear 
under a group heading called “Table Tools” (see next page). Here are some of the most used ribbons: 

View Ribbon  -for changing the way the pages are displayed and turning on features like the ruler bar. 

Mailings Ribbon  -labels and mail merge. 

Review Ribbon  -thesaurus & translation, as well as the controls for tracking changes. 

References Ribbon  -footnotes and other document commenting. 

Insert Ribbon  -for inserting tables, pictures  and shapes as well as controls for the header & footer. 

Home Ribbon  -font and paragraph formatting, and cut, copy & paste controls. 

Layout Ribbon  -for adjusting page margins, orientation, size, columns and the various types of “breaks.” 
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“Smart” Ribbons (which appear when doing certain tasks) 
Some ribbons, called Smart Ribbons, appear based on what you are doing. For example, when you are working in 
a table, ribbon tabs labeled, Design and Layout appear under a group heading called “Table Tools.” 

Table Tools—Layout Ribbon   

Table Tools—Table Design Ribbon   

The Quick Access Toolbar and Hiding the Ribbon 
The Toolbar, located in the upper left initially contains a few icons plus a pulldown arrow. The toolbar can be 
customized where you can add many other icons (commands) to it.  

Sometimes, a person may have somehow hidden 
(collapsed) the ribbons. This can be controlled by right-
clicking on any tab (here the Layout tab) to control the 
display of the ribbons. 
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Starting a new document 
 
Although Word opens a new blank document when you start the program, you should understand the different 
ways to create a new document. 
 
Keyboard Shortcut -The quickest way to create a new document is to press the keys Ctrl-N on your keyboard. 
 
Office Button of older word versions has been replaced with the File tab 
Click the File tab and then click New menu command, which displays the following screen 
below.  This screen is called the Backstage View. Aside from giving you access to the various 
templates you may have saved on your computer, it also gives you access to many other 
features, like connecting your copy of Microsoft Office to your Microsoft.com account. 
 

The templates section contains a library of pre-defined documents to give you a head start on your 
work. There is even a search box that you can type a simple description of what you are looking for. 
CAUTION: the templates from Microsoft are chock-full of advanced Word features; if you try to delete 
some, you can quickly alter your document beyond recognition. Be careful or avoid major deletions 
and formatting changes—have your finger ready to hit the UNDO button! 

Word version 2019 

Program Account info 

Program Options 
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Opening Existing Documents 
 
Click the File tab. To the right 
of the menu will be a list of 
the most recent documents 
that were saved.  Simply click 
on the one you want if it is 
there.  If the one you want is 
not on that list, click the Open 
button on the left.  A more 
detailed window (bottom of 
this page) will appear, with a 
longer list of files that have 
been saved from this 
computer.  

Additionally, this Open mode will 
present you with more options: 
 

• OneDrive cloud storage account. 

• Share, For access to a file that is in 
another person’s OneDrive cloud 
storage account. 

• Copy Link, Is use when you save 
and send a link to where the file 
lives on your OneDrive cloud 
account. 

• This PC, which all Word 
documents in the current folder 
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Saving a Document (for the first time) 

 
The process to save a newly created 
document is simple — BUT, you must pay 
attention to where you put that document!   
 
Either click the Save button or click the 
Office button and choose Save from the 
menu.  The save dialog (shown below) will 
appear.  There are two steps you should focus 
on:  
 
1. Select the folder location where 

you want to save the document.  
Commonly, people don’t pay 
much attention to this, letting 
the file land wherever the 
program is pre-set for.  Recent 
versions of many Windows 
programs set this automatically 
for the  Documents folder in 
the C: drive. 

 
2. Give your document a filename.   
 
3. Choose the file type to save it as.  

Normally, you would save 
everything as a “Word 
Document,” but it is important to 
note that this is where you can 
choose to save you save it as a 
PDF file. 

 

NOTE: Once you’ve saved a document, and do some work on it, Selecting Save again will not bring up this 
window again.  Your document changes will be saved same filename in the same location. 

Save Button 
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Displaying Paragraph Marks, Spaces and Tabs 
It will be easier understand how the text is spread out in your document if you display the non-printing characters 
that identify where items like paragraph marks, spaces and tab stops are.  Click on the Show/Hide button on the 
Home ribbon (see below). 

Spaces: 
The dots between the words 

Paragraph Marks 

Tabs 

Undo — the "forgiving" command 
You shouldn't become too concerned about making errors and executing functions you did not intend — because, 
in many programs, you have the "undo" function at you disposal.  It's found on the Toolbar, and many programs 
allow you to run it repeatedly to work backwards over several tasks that you may have done.  And if you undo 
something you wanted to keep, you can always use its cousin, the "redo" function!  You can also use their 
keyboard shortcuts, Ctrl-Z and Ctrl-Y. 

Undo (Ctrl-Z) 
Click once per step to 
move “back in time” of 
your work history. 

Redo (Ctrl-Y) 
Click once per step to 
move “forward” to repeat 
the “undone” steps. 

The “pull-down” arrows that may appear to the 
right of each of these buttons allow you to see a list 
of steps that can be undone (or redone) quickly—
in one shot! 

Turn on “Non-Printing” characters 
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Selecting Text—With the Mouse 
Before you can format any text in Word, you must select it.  Once selected, you can change the font, font size, col-
or, bolding, italics, etc.  There are many ways to select text, and shortcut methods are provided whether you are 
selecting one character or a word, or a sentence, etc.  You can select text by using the mouse, the keyboard, or a 
combination of methods, depending on how much text you want to select. The following list describes the methods 
of  text selection. 

To select one word when you are changing the font characteristics, you only need to place the insertion point in the 
word, not select the entire word. If you are using an older version of Word, to select one word, position the I-beam 
pointer anywhere in a word and double-click. The word and the space following the word are selected. 

To select a sentence, hold down the Ctrl key while clicking anywhere in the sentence. Word selects all words in the 
sentence to the ending punctuation mark, plus the blank space following the punctuation mark. 

To select a paragraph, triple-click the paragraph, or place the mouse pointer in the selection bar, and double-click. 
The selection bar  is a vertical white space to the left of the workspace. When you point the mouse in the selection 
bar, the I-beam pointer changes to a right pointing arrow (see below). 

To select specific text, click and drag the I-beam pointer over one character, one word, or the entire screen. 

To select one line of text, place the mouse pointer in the margin area to the left of the line, until the mouse pointer 
changes to a right-pointing arrow, and click once. 

To select the entire document, hold down the Ctrl key while clicking in the left margin area. Alternatively, press 
Ctrl+A to select the entire document.  A third was exists...from the menu, choose Edit—Select All. 

Selecting Text—With the Keyboard 
To select text with the keyboard arrow keys, position the insertion point where you want to start selecting, press 
and hold down the Shift key, and then press the appropriate arrow key to move up, down, left, or right. 

To select to the end of a line of text with the keyboard, position the insertion point where you want to start select-
ing and then press Shift+End.  Alternatively, select to the beginning of the line of text by pressing Shift+Home. 

To select a block of text, position the insertion point where you want to start selecting, move the mouse pointer to 
the end of the text you want to select, hold down the Shift key, and click the left mouse button. 

To deselect text, click once anywhere in the workspace of a document or press an arrow key. 

CAUTION! 
If you have text selected and press the space bar or any character key, the 
selected text is deleted and is replaced by the characters you typed. 
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Cut, Copy and Paste 
Unlike a typewritten page, you can easily change the arrangement of text in 
your document, by deleting it (Cut), duplicating it (Copy) and relocating it 
(Paste). 
 

1.  Select the text or graphics you want to move or copy. 
2.  To move the selection, click Cut  . 
 
To copy the selection, click Copy  . 
 

3.  Click where you want your text or graphics to appear. 
4. Click Paste. 

 
NOTE:  If you want to move or copy the text or graphics to another 
document, switch to it. 
 
Drag-and-Drop Editing 
Another method you can use to move or copy text is called drag-and-drop editing. Word supplies this shortcut for 
moving or copying selected text. You also can use drag-and-drop editing to copy or move graphics or other 
objects. 
 
To use drag-and-drop editing to move text or graphics, follow these steps: 
 

1. Select the text or graphics you want to move. 
 
TIP: To copy the text or graphic instead of moving it, and hold down the Ctrl key as you point to the selected text 
or graphic, and drag the dotted insertion point to a new location. 
 

2. Point to the selected text or graphic and hold down the left mouse button. The drag-and-drop pointer 
appears  

 
3. Drag the pointer and the dotted insertion point that appears to the new location and release the mouse 

button. 
 

Moving Around Your Document Using the Keyboard 
 

Key     Moves Insertion Point 
Arrow Keys    One character up, down, left, or right 
Page Up/Page Down   One screen up or down 
Crtl+→ or Ctrl+   One word to the left or right 
Home     Beginning of a line 
End     End of a line 
Crtl+Home    Beginning of the document 
Crtl+End    End of the document 
Crtl+Page Up    Top of the next page 
Crtl+Page Down    Top of the previous page 
Alt+Crtl+Page Up   Top left of screen 
Alt+Crtl+Page Down   Top bottom right of screen 

 
F5 is the Go To key. Press F5 in Word and then type the page number to go to.  



Paul J. Montenero paulj@clearcutcomputing.com Page – 11 
Clear-Cut Computing (516) 845-4081 www.clearcutcomputing.com 

Microsoft Word I — Essential Skills 

Text Formatting 
Text is a part of almost every program.  Therefore, the most basic formatting functions will exist in just about all 
programs.  Word, therefore, has extensive formatting capabilities available from the Home tab on the Ribbon  
What remains generally consistent between different programs is the text formatting controls on the Toolbar — so 
what you learn here may be carried over to other programs, such as Excel and PowerPoint (and even non-
Microsoft programs!). 

Font Type or name 
Use the drop-down arrow 
to view a list of choices. 

Font Size  
Use the drop-down arrow 
to view a list of choices. 

Bold 
 
Italics 
 
Underline 

Font Color  
Use the drop-down arrow 
to view the color palate. 

IMPORTANT: you must select the text you want to change, before you apply the desired formatting changes. 

Font Dialog Box Method 
When you click the Font Dialog Box button from the Home 
Ribbon, the window at the left will pop up, giving you more 
options and control over the formatting details. 
 
For example, there are more underlining options available 
on its pull-down menu. 

Alignment Options  

J    u    s    t    i    f    y  

Align Left 

Center  

Align Right  

Quick Font  
Increase & Decrease 



Paul J. Montenero paulj@clearcutcomputing.com Page – 12 
Clear-Cut Computing (516) 845-4081 www.clearcutcomputing.com 

Microsoft Word I — Essential Skills 

Paragraph Formatting 
Word will automatically wrap the text you type, as you reach the right margin, to the next line along the left 
margin.  So, there's no need to "manually" press the Enter key when you feel the line is long enough. 
 
Spacing 
By default, Word 2007 and 2010 adds extra space between paragraphs to improve readability in your documents 
and to add valuable white space. White space, or areas of a page that contain no text or graphics, provides rest of 
the reader’s eyes and prevents the page from being too crowded. Readability often is improved when you add 
space between paragraphs.  To change this setting, first select the paragraph(s) you wish to format. Then, click the 
Paragraph Dialog Box button in the Paragraph section of the Home Ribbon..  The Indents and Spacing tab 
contains a host of  spacing options.   
 
Before & After  —Adds extra height to either the first (Before) or the last (After) line of the paragraph.  This extra 
height is measured in points—just like the font size.  This controls that extra space between paragraphs. 
 
Line Spacing —Forces each line to expand and take up extra space.  The choices available are: 
 

Single   Default line spacing (two to five points larger than text size). 
 

1.5 Lines  Spacing that is one and a half times the size of the normal spacing. 
   For 12-point spacing, the spacing is 18 points. 
 

Double   Spacing that is twice the size of the normal spacing. 
   For 12-point spacing, the spacing is 24 points. 
 

At Least   Accommodates larger font sizes within a line of text. In the At box, 
   enter a specific line spacing amount that Word can use as minimum 
   spacing. To allow for a larger font, for example, 12-point text that 
   includes some 18-point characters, the spacing is 20; if you enter 20 
   in the At box, spacing is adjusted to 20 points. 
 

Exactly   Limits Word to a certain amount of spacing, entered in the At box. 
 

Multiple   Decreases or increases line spacing by the percentage you enter in the 
   At box. To increase spacing by 20 percent, for example, enter 1.2; to 
   decrease spacing by 20 percent, enter .8 
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Paragraph — Indenting & Tabs 
Word will automatically wrap the text you type, as you reach the right margin, to the next line along the left 
margin.  So, there's no need to "manually" press the Enter key when you feel the line is long enough. 
 

Ruler 
The ruler is more than just a measuring tool to help you place text in the right locations.  To display the ruler bar, 
click the View ribbon and check the Ruler box.  By moving the left and right indent controls,  you can control the 
width boundaries of your text.. 

Tab stops 
You also use the ruler bar to control where you place your tab stops.  There are 
four kinds of Tab stops: Left justified, Center, Right justified and Decimal tabs. 
 
A Decimal tab stop is the numeric tab stop— it will line up numbers vertically by 
their decimal point. 

Click to select Tab type... 

-Left Align Tab 
-Right Align Tab 
-Center Tab 
-Decimal Tab 

...then click on ruler to place tab stops 

Indent controls 

Left Indent 
First Line  
Hanging 

Total Indent 

Right Indent 
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Spelling & Grammar 
Word has a built-in dictionary and thesaurus to check you spelling and grammar as you type.  You may notice, that 
as you author your document, you occasionally see red and/or green scribbled lines underneath one or more words.  
 
 Red wavy lines — indicate that you may have made a spelling error. 
 

 Blue double lines — flag possible grammar errors. 
 
It's very easy to fix these errors; simply point your mouse 
at the word and press the right-click button.  A list of 
possible corrections will appear on the subsequent menu.  
Just click on the right correction and it replaces your 
error. 

Bullets and Numbering 
A nice way to make your document look professional is to employ the use of Bullets and Numbering.  When you 
are at the desired location in your document, click the Bullets or Numbering button on the Home ribbon, then type 
your text…. 
 
 
 
 
 

 
 
 
 
 

Bulleted List 
Numbered List 

Multi-Level List 
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Page Breaks 
During your typing, you may decide that you want to start a new page for the next section of your document.  
Position your cursor where you want the new page to begin, and click the Insert tab, then click Page Break on the 
ribbon.  Alternatively, press Ctrl-Enter on the keyboard after you position your cursor. 

Headers and Footers 
 
. 
1. Accessing the Headers and Footers area of the page can be done through the Insert tab but it is easier to simply 

Double-Click in the white page space at the top or bottom of the page. 

2. The text in the body of your document should turn a light gray, and two outlined areas will appear in your page: 
scroll to the top to see the Header area; scroll to the bottom to see the Footer area. 

3. The Header and Footer Ribbon tab will appear in a Smart Tab the ribbon to help you with related features. 

4. You can scroll up  to the Header section and type some title you might want, and... 

5. Scroll to bottom, click inside the Footer area and add what you want to display in the bottom of each page. 

6. There are buttons in the ribbon for you to add a page number, date and other informational elements 

7. Click the red Close button on the Header and Footer ribbon, and scroll through some pages to test the results. 
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Find and Replace 
 
You may find that reviewing a document 
is easier if you can quickly locate 
specific text or formatting in different 
sections of the document. The Find 
command, on the Home Ribbon, enables 
you to search for specifics in your 
document. If you use the Replace 
command instead, you not only find 
what you are looking for, but you can 
then replace what you found with 
something else. For instance, you can 
find the word place and replace it with 
word put (see the figure at the right). 
 
 
To use the Find command, follow these steps: 

1. Choose Find or Replace on the Home Ribbon.  The dialog box appears (and actually, on the dialog window, 
there are separate tabs for Find and Replace, as well as Go To). 

2. In the Find What text box, type the text you need to find. You can choose the More button to choose one or 
more options in the Find dialog box to enhance your search. These options are described later. 

3. Choose the Find Next button to find the text. 

4. When you get to the first occurrence of the item in the Find What text box, you can choose Find Next again. 
Cancel, or the Replace tab. 

5. If you chose the Replace tab, type the text you want to use in the Replace With text box. You can choose one 
or more options in the Find and Replace dialog box to enhance your search. 

6. To replace the found text, with new text, choose the Replace button. 

7. Click the Replace button again to replace and look for the next occurrence of the found text. 

 
TIP:  The keyboard shortcut for Find is Ctrl+F; the shortcut for Replace is Ctrl+H; Shift+F4 repeats the last find. 
 
NOTE:  If you want to use the Replace command without first using the Find command, you can choose Replace 

or use the keyboard shortcut, Crtl+H to display the Find and Replace dialog box with the Replace tab the 
active tab. 

 
When you are finding or replacing text, you have a number of options for your search.  These options are 
accessible by clicking on the More button. The following is an explanation of the most commonly used options on 
the Find and Replace dialog box: 
 

Search    Searches forward (Down), backward (Up), or through the entire 
    document (All). 
 

Match Case   Matches capitalization (uppercase or lowercase) when searching 
    for text. 
 

Find whole words only  Finds a match that is an entire word only (if you are looking for 
    the, Word doesn’t find other or their). 
 

Use Wildcards   Use with special characters (? Is a wild card for any one character, 
is a wild card for any number of characters). S?t will find Sat, Sit, 
Set, S*t will find all the preceding items as well as Soot, Sachet, 
Saddest and others. 
 

Special    Searches for special characters such as paragraph marks, tabs, 
    line breaks, and others. 
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Inserting Pictures & Clip-Art  
 
One of the best ways to spice up a document is to insert photos or a clip-art drawing. The Clip-Art Gallery contains 
many drawings that cover a wide range of topics. Adding pictures is now being used to create much clearer reports 
and advertising flyers in today’s business world. 

 
To add any of these to your document, follow these steps: 

1. Position the cursor where you want the image to appear in your document. 

2. Click the Insert tab on the Ribbon and choose one of the selections in the Illustrations group. Depending on 
what you choose, you may be given a list of source choices or a window to navigate to what you wish. 

3. Select an item and click on it to place it where your cursor was in the document. 

To insert a Picture, photo or clip-art image that you downloaded from the Internet or purchased, go back to Step 2 
and chose Pictures from the Insert ribbon and select what kind of picture. 
 
The Picture tab will appear in the Ribbon. You can use the commands on this Ribbon to fine-tune your picture, or 
right-click on the picture and choose Format Picture from the pop-up menu.   
In most cases, you’ll need to adjust the size of the picture.  While you can do this by dragging any of the picture’s 
handles (the eight little squares surrounding the picture), you may distort the picture.   
 
It may be better to use the Size controls on the right of the Picture Ribbon or right-click on the image and choose 
Size to adjust the Height or Width settings.  If you don’t want the picture to distort, be sure that the Lock aspect 
ratio box is checked. 
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Printing Basics 
 
Print 
Click the File tab and 
choose Print. Since 
Office 2013, the Print 
Preview is shown 
alongside the Print 
controls where you can 
readily set several 
important print 
parameters like, the 
number of copies, 
orientation, paper type, 
as well as which pages 
to print. Many of these 
and more are also 
configurable on the 
Layout tab. 

Margins 
Margins are shown in inches.  
The four most common 
margins are Top, Bottom, Left 
and Right.  This sets the 
boundaries of the printing from 
the edges of the paper.   
 
NOTE: Before setting any 

margin to a very small 
value (such as 0.25"), 
check your printer 
documentation.  Many 
printers have a region 
where they can't print 
to. 

Orientation 
Found on the Margins tab, Orientation refers to the 
layout of the paper.  Normally we write and print our 
work on an 8-1/2 x 11 inch piece of paper in Portrait 
orientation.  But if we rotate the paper 90 degrees, we 
call it Landscape. 
 
 
 Portrait 
 
 
 
 

 Landscape 
 

 

A 

A 

More advanced page settings 

• Use the Printer Properties  hyperlink, below the printer selection, to make further adjustments for the 
selected printer. 
 

• Use the Page Setup hyperlink, at the bottom of the Print list selection, to make detailed settings changes on 
the classic Page Setup screen. This can also be accessed from the Page Setup dialog window button on the 
Layout tab. 
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Some Useful Keyboard Shortcuts 

FONT FORMATTING 
Cut Ctrl+X 
Copy Ctrl+C 

Paste Ctrl+V 

Bold text Ctrl+B 
Italic text Ctrl+I 

Underline text Ctrl+U 
Increase Font Size of Selection Ctrl+] 

Decrease Font Size of Selection Ctrl+[ 
Change case (text—Text—TEXT) Shift+F3 

Open Format Font Window Ctrl+Shift+P 
Insert today’s date at the cursor Alt+Shift+D 

 

PARAGRAPH FORMATTING 
Single space the paragraph Ctrl+1 

Double space the paragraph Ctrl+2 
Line-and-a-half spacing Ctrl+5 

Center  Ctrl+E 
Align Left Ctrl+L 

Align Right Ctrl+R 
Align Justify Ctrl+J 

Indent Ctrl+M 
Create a Page Break at the cursor Ctrl+Enter 

New Line in paragraph (does not skip space) Shift+Enter 
 

MOVING AROUND 
Go to the Beginning of the Line Home 
Go to the End of the Line End 

Go to the Beginning of the Document Ctrl+Home 
Go to the End of the Document Ctrl+End 

Go to the Top of the Next Page Ctrl+Page Down 

Go to the Top of the Previous Page Ctrl+Page Up 
Go to the next or Previous word Ctrl+arrow 

Undo the last command Ctrl+Z 
Redo the previous Undo action Ctrl+Y 

Print Preview Alt+Ctrl+I  or  Ctrl+P 
 

SELECTION TIPS 
Select All Ctrl+A 
Double click on a word to quickly select that word.  

Triple click on any word to select the entire paragraph.  
Ctrl-click on a word to select the sentence.  

 

MISCELLANEOUS 
Delete the word to the RIGHT of cursor Ctrl+Delete 
Delete the word to the LEFT of cursor Ctrl+Backspace 

Insert today’s date at the cursor Alt+Shift+D 
New Document Ctrl+N 

Spell Check  F7 
Thesaurus Shift+F7 

Save the Document Ctrl+S 


